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> OK
C:\GDSLAB\

Common Windows files may be running when the installation procedure tries to overwrite them
and an error message will be displayed. This may be OK if you can choose to ignore this and
continue, but make a note of the files the PC rejected. You may be asked to re-boot your PC

before proceeding.

The setup procedure will install the following to your PC:

e GDSLAB kernel and associated compulsory files.

e All device drivers available at the time of the release of the CD.

The GDSLAB kernel is now ready to run but will not be able to perform any testing yet. A
GDSLAB icon should have been added to your ‘Programs’ directory, along with an icon for the
Installation Manager. Before you can run any tests, the installation manager must be run to install

following additional components, namely:

e Test Module(s) — at least one test module must exist on your PC.

e Hardware Configuration file— this file describes the connectivity of your hardware.

and finally...

e The software is security protected by a HASP ‘dongle’. Software for this dongle will

need to be installed.

2.3 Second: Using the Installation Manager

The installation manager should be run by either selecting it from the Programs directory (a), or

from within GDSLAB on the management toolbar (b).

(a) from desktop (b) from within GDSLAB

Security

L] T R SRRt L

B Gdsab J Gddat

£ HASFLD 70 ¥
(B Losghuch Mousswain ’
|5 Microsolt Difics Took C
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When the Installation Manager is run a screen will appear as follows:

GDSLAB Installation Manager

laslaahin i faher sl Gt
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M ran karealmefds
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The buttons labelled 1 — 5 on the left of the form are the individual sections for additional
installation. These should preferably be followed in order (i.e. 1 to 5), where at each stage
decisions need to be made about what components need to be installed/are required for your
system. Note: there is no need to install everything! — only install those components you require,

you can always come back and install additional components at any time.

I Test Modules I

Selection 1 (Test Modules) will browse the GDSLAB CD to the ‘Test Modules’ directory. A

separate list of Test Modules available on the CD are situated within this directory. Each test

module allows a different suite of tests to be run. Within the Test Module directory, browse into the

directory of your chosen Test Module, then click ‘Go!...".

Salect the ragquined Test Type from directanss avalahle sithin
the Test Modules' drechony

T et Mahist

Gol... |

Remember: There may be more test modules on you CD than are actually enabled by your GDS
HASP security dongle (key which is inserted in the back of the PC). In which case it is only

sensible to install those modules that you know you will have access to. To enable other modules,
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contact GDS and ask for a remote dongle update. Test modules that have not been purchased

will only run as demonstration versions and will not save any test data.

Station INI files

When you choose to create a station, the program will look for any file with the .ini extension
within the C:\GDSLAB\ directory. This file describes the hardware and the way each transducer
or control parameter is connected to your computer for a particular station. This is what gives
GDSLARB the flexibility to run different hardware configurations as defined by the user.

Clicking on the ‘Station INI files’ button will show the following form:

Selact e mauined Shatan Infaksalion fike [~ini) form Hose seailshle
‘Hardwana Corfiguration Filas' drechon:

ADVTTS[Pad_Jckini

ADTTS|Fad_ Skl ALPTTS fo Bichug el "whaciley bupe
poeell wathy s kbl By

= T

!Hac.--el: E-:-*li.idn:n Fless

Gol...

A list of Hardware Initialisation Files (INI files) available on the CD are situated in their own
directory within ‘Hardware Configuration Files’. Each *.ini file describes a different hardware
configuration. When an ini file is selected a description of its Station Setup appears on the right of
the screen in the yellow box. Press ‘Go!..." to transfer this file to the C:\GDSLAB directory ready

for use when GDSLAB is next run.
Contact GDS if you are unsure as to which ini file you should run, or you would like a custom
Hardware ini file made for your individual requirements (free of charge of course!).

Each test module allows a different suite of tests to be run.

The program utility called “Visual Planner” is designed for creating your own hardware

configuration files from new.

HASF Install

An essential step of the GDSLAB installation is to install the security module. This will activate all

of the purchased test modules.
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Simply pressing ‘Go!..." on the screen below will activate the full installation process for the GDS
HASP key. If the program does not find a HASP directory on your CD, it will allow you to browse
to a floppy disk (sometimes the hasp security key files are distributed on a floppy disk). Simply
browse to the root directory of the correct floppy, and click ‘OK’, or select the “Floppy (A:)” option
box.

5 - Install GDSLAB securty = o

kev (HASP) ey _GOL-

Check Modulas
Enabled for Hasp

Plug the security module (dongle) into the computer’s parallel port and GDSLAB is ready to use.

The files that comes with the security module are specific to that dongle, and no others.
When the security software has been installed, only the dongle relating to this software will
enable the test modules. The dongle itself holds keys to enable particular test modules.

To enable further test modules on your dongle, contact GDS Instruments Ltd for details.

Install Extras

This option simply allows for easy installation of any additional programs/utilities that are available
on the GDSLAB CD. Simply select the required utility and press ‘Go!..." to install. The example
below shows installation for Adobe Acrobat Reader — required to be installed on a PC before this
manual may be read as it is in pdf (*.pdf) format (the manual may be found on the GDSLAB CD in
the directory ‘GDSLAB Manual'.

7 Install Adebe Acrobal Reader
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I Dbi. Manager I

The Object Manager is a tools for viewing all of the GDS dII's (dynamic link libraries) currently

installed on the PC. The version number and a short description of the file is displayed.
From the Tools menu, all of the files installed may be printed (to a file or a printer), to enable
diagnostics and version conflicts to be addressed. Also from the Tools menu, files may be

registered and unregistered easily if required by GDS.

To return to the Installation Manager select this option from the File menu item.

..".'f‘" Object Manager I
File Toolz About

] GDS_tStressPaths,di Name |[GDS_Hasp.dl

[]GDS_MI4222.dl

“ersion|1.1.1

short description
G0S HASP secunty module

2.4 Internet download (not currently available).

Internet downloads of all software modules and latest hardware devices will be available
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Test Station

3.1

GDSLAB
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File ‘Windows Help

Test Status

= Click here to begin

&' GDSLAB v 2.0.4

File ‘Windows Help

Test Status
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OK
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Single Directory “ " ‘Next>’

Paiwiconabigm 3]

- Data Saving Format

.gds — GDSLAB
tas — GDS GDSTAS
s — GDS STDTTS

- Data Saving Type

Linear - %
Sqr-root  — % X( )2
Log - % X EXP( )
X Data Saving Interval

- Save Calculated Data

GDSLAB
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3.4

Station Test Plan Specimen Details

Specimen Details

Specimen Details National Standard

BS1377

Setup Sample Details
Sample Details

GDSLAB 1]

Is this the First test on a new specimen?

Yes Mo |

If you answer YES

If you say NO
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cosian

Iz the specimen docked?

Yes Mo |

113 ” iDOCkedl
“ " Undocked
35 *

" see section 3.5 entitled “Docking and Undocking”

Initial Sample Dimensions

[Pk = er
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T S | =

Ram Diameter

OK
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LRV Review

Sample Details Sample

Sample Details Review
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the back volume

and the axial displacement transducer are set to zero
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3.6

Test Plan Add Test Stage

Specimen Details Frame Add Test Stage

GDSLAB

Add Test Stage

Create New
Test Stage

Test Module Test Module
Details Test Module Details
6 Chapter 6 Test Module Details
Test Module Test Plan
“ \/ ”
Create New Test Stage Test

Stages
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Test Stages Station Test

Plan Test List
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Plan
Test Plan Test Plan
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Review

Test Stage

Go to Test

3.7

“ " Test List

*.pln “
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3.8

Go To Test
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Start Test » | Ne:-:tStage}}l

|' Test Control

g Test Plan ==l

Live Test Date

Live Date Browse Live Data Options
3.8.1
3 3 Graph Tabs 3 2 Y
3.8.2 The
Data tab Live Data
Live Data
3.8.3

(Browse Live Data Options)

(Station Test Options) Graph
Selection (Browse Live Data Options)
(Station Test Options) (the Live Test Data Options)
Graph Options Test Display
Single Graph 1 Double Graph 2 3
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OK
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3.10

GDSLAB
1. GDSLAB
2. Microsoft Excel
3. GDSLAB Reports ( )
GDSLAB
GDSLAB Test Display
GDSLAB Plot from
File
Select
Plot from File

—

b Pl | el Fles bt i © 000 6 LA 0 k) [ E
= | Exdior Sl
] T

Test Display

The test data is displayed as if it were at the end if the test when it was performed. The data to be

plotted on the graphs can be changed just as when running a test.
To clear the data after displaying previously saved test data is the same as when clearing data
after performing the test. Click on the Station icon on the left of the screen and then select Clear

all test details.

Note: To display previously saved test data in GDSLAB it is necessary to have the same
initialisation file selected as was used to carry out the test.

Opening in Excel

The best way to display previously saved GDSLAB test data is to open the file using Microsoft
Excel. This then gives you the flexibility to manipulate the data in many different ways, perform

calculations using the test data and to plot the data.
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GDSLAB datafiles are saved as comma delimited text files, therefore can be imported into Excel

so that the test data appears in columns of data.

To open the GDSLAB data file in Excel:

e Firstly open Excel

e Click on the Open button and in the File Open window set the Files of Type to All Files,
then select the GDSLAB datafile be opened.

e Excel will then display the Text Import Wizard. On the first page make sure that the
Original data Type is set to Delimited. Then click on Next.

e On the next screen of the wizard, put a tick in the box for the Comma delimiter. Then click
on Finish.

e The data from the GDSLAB data file will now be displayed in columns of data.

Note: Do not set Windows to automatically open files of type .gds using Excel. The file will not be

opened using the Text Import Wizard and the data will not be displayed correctly.

Opening in GDSLAB Reports

GDSLAB also give the user the option to save test data in the GDSLAB Project Structure for use
with the GDSLAB Reports presentation software.

GDSLAB Reports provides a way to automatically generate test reports in Excel format with all the
data, calculations and graphs necessary to present the test data to National Standards, for
example to British Standards (BS1377).

GDSLAB Reports is designed to be used in conjunction with the GDSLAB control and acquisition
software or as a manual input reporting package on its own. The design of GDSLAB Reports
allows for flexibility in the way that the data is presented by using the power and simplicity of
Microsoft Excel spreadsheets for report presentation. This allows users to customize their reports

using software they are already familiar with.
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Transducer Control Parameter
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5.1.2

3 Transducer and Control Parameters
Acquisition Devices and Control Devices Computer

Connection Devices

RS232 IEEE
RS232

“ " ADVANCED
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Parity = o (odd)
Data Bits = 8
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Amplitude; kM
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. Total Cycles
. Points per Cycle
— 8 16 32
. Cycles On
. Cycles Off
° Hold Pressure at end of test
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Average Radial Strain , r (%)

x 100

Deviator Stress , q (kPa)
q= -
Stress Ratio

/

mm?

mx  Dg2 < HO +
Ho-

Axial Force , (kN)

Axial Stress a (kPa)

/

(Effective Axial Stress), a’ (kPa)
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(Axial Strain) (%)

( / Ho) x 100

Average (Mean) Stress , s (kPa)

( + )/2

Maximum Shear Stress ,t (kPa)

/2
Shear Strain

( + ) x 2/3

Average Effective Stress  (kPa)

( + )/2

Cambridge p (kPa)
( +2x( N/3

Cambridge p’ (kPa)

p —_—
Do =
Ho =
/ x 1000
/ x 100
X /100
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x 100- /100

KRT PV=KRT

KRT/ +
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